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Lesson 3 

Library Project: FLOOR PLANS – Part 2:: 
 

In this lesson you will continue to develop your floor plan for the Campus 

Library project; in the previous chapter you drew the walls, doors, windows 

and columns/grids. Throughout this lesson you will be introduced to a few 
new commands and design concepts. Specifically, you will add stairs, 

elevators, toilet room fixtures and casework. 

 

The image below is anther reminder of what your plan will look like when you 

finish Lesson 4. Notice, again, the classrooms in the lower-right, the office 
area in the upper-left, the main toilet rooms in the lower-left, the public 

concourse across the top, and the check-out area in the middle. 

 

It is important to remember that your drawings are to comply with the “office 

standards” outlined in Appendix A; this includes layer naming conventions, 

lineweight standards (which is based on the lines color), dimension and text 
standards, dimscale and ltscale settings, and abbreviations. As previously 

mentioned, this is intended to simulate a real-world office environment. 

 

 

 

Overview:  Example of what will be drawn in this book - First Floor Plan 
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Exercise 3-1: 

Toilet Room Layout 
 

Introduction  
There are several important factors in laying out a toilet room. The primary 

consideration is typically accessibility; that is complying with local, state and 
federal accessibility codes so that people with various handicaps can easily 

access and use the toilet room facilities (or the entire building in general). 

 

Other considerations include sight-lines. It is undesirable for a person in the 

hallway to see any of the toilet fixtures when the door is being opened by 
someone entering that space. It should be obvious that privacy (especially 

between males and females) should be expected in a toilet room design. 

Seeing the sinks (i.e. people washing their hands) is not too bad but the 

designer needs to make sure the sight-lines are not extended by the mirror 

above the sink. The design techniques employed to impede improper sight-

lines often takes up a fair amount of floor space. 
 

Another consideration has to do with the plumbing fixtures. It is important to 

have the correct type of fixture drawn and have it drawn the correct size. 

Some of the code requirements are based on the clear space in front of the 

fixture; thus, the fixture needs to be the correct size in order to verify 
compliance. Also, whether the fixture is wall-hung or a floor mounted tank-

type fixture is important; the mechanical engineer needs to know (they 

specify the fixture in the Project Manual). If the toilet is wall-hung the wall 

needs to be thick enough to conceal the support bracket and the plumbing 

(the wall is even thicker when two toilets are back-to-back). From an Interior 
Designer stand point, wall-hung toilets are often desirable in commercial 

buildings because they are easy to clean under and can be equipped with 

automatic flushing to help ensure a better “space experience” for everyone! 

 

Downloading Content from the Internet 

In the next several steps you will get a better understanding of how you can 

get CAD content from the internet to use in your drawings.  

 

A word of warning before proceeding: 

Do not assume all CAD content found on the internet is worthy 
of using in your drawings. They are many locations on the web 

where individuals have uploaded CAD drawings that are less 

than perfect – so use caution. On the other hand, if you are 

downloading content from a product manufacturer’s website you 

can be fairly confident that they have accurately drawn their 
own product and want you to have a successful project using 

both their product and CAD files! 
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In this exercise you will be instructed on how to download toilets, sinks and 

drinking fountains for a plumbing manufacturer’s website. The AutoCAD 

drawing files you download will be saved to your hard drive and then inserted 
using the Insert Block command.  

 

In an office setting you might want to save the downloaded plumbing fixture 

drawings to a “Plumbing Fixtures” folder on your hard drive for convenient 

access in the future. 
 

You will need to have access to the internet for the next several steps… 

 

1. Open your Internet Browser; this book uses MS Internet Explorer. 

 

Next you will be instructed to browse to a major plumbing manufacturer’s 
website. 

 

2. Browse to the Kohler website by entering the URL 

www.kohler.com and then press Enter…  or click Go. 

 
 

 
 

 
 
FYI: As you should be well aware, websites can change at any given moment. 
Companies often update their websites as new content becomes available or a fresh 
new look is desired. Even the model numbers change from time to time. So if the 
screen shots shown here are different than what you see on your screen you will 
have to interpret the steps based on what you see; you will likely still have access to 
the same content. 

 
3. Click on Kitchen and Bath and then click in the textbox next to 

Search at the top of the webpage; type k-4328 and press Enter. 

 

4. Click directly on the toilet image (the one without the bedpan lugs) 

(see Figure 3-1.2). 
 

Figure 3-1.1 Website: www.kohler.com

Copyrighted 
Material 

 
Copyrighted 

Material 
 

Copyrighted 
Material 

 
Copyrighted 

Material 



Interior Design using AutoCAD 2007 

3-4 

 

 

Take a minute to review the features 
of this toilet fixture. 

 

5. Near the center-bottom of 

the page, click TECHNICAL 

INFORMATION and CAD 

SYMBOLS. 

 

The previous step expands the 

webpage to show more information 

(see Figure 3-1.3). 

 
 

 

 

 

 
 

 

 

 

The next link you are instructed to click will allow you to save a CAD file of 
this fixture to your hard drive. If in a classroom setting, your instructor may 

direct you to save these files to a different location. 

 

 

6. Under DWG CAD Files, select 2D Plan View. 

Figure 3-1.2  
Website: www.kohler.com; search results 

Figure 3-1.3  Website: www.kohler.com; downloading CAD Files 
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Make sure you selected DWG CAD Files and not DXF CAD Files. The former is 

the native AutoCAD file format and the latter is a file format conceived by 

Autodesk to allow designers to share CAD information between AutoCAD and 
other CAD programs not written by Autodesk. The DWG file format is more 

readily inserted into your current drawing than DXF (Drawing eXchange 

Format). 

 

7. Click Save in the File Download dialog box (see Figure 3-1.4a). 
 

 
 
 

 

8. Browse to your My Documents folder and click Save (Figure 3-

1.4b). 

 

 
 

 

You now have a copy of the toilet fixture on your hard drive and it is ready to 

place in your floor plan! 

Figure 3-1.4a Saving a file from the internet

Figure 3-1.4b  Saving a file from the internet
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The file you just downloaded is named 4329pln.dwg (unless you renamed it 

in the previous step); the name is the model number plus the view (pln for 

plan view in this case). If you open the file directly you will notice the origin 
has been conveniently located at the back/center of the fixture and all lines 

are on Layer zero. Having all lines on Layer zero is preferred; this way all 

lines in the Block will take on the properties of the Layer the Block is placed 

on. 

 
Next you will be instructed to download the other fixtures required for your 

floor plan. Rather than giving you step-by-step instructions you will simply be 

given the model numbers – you can then find and download the other 

fixtures using similar techniques to those just covered. TIP: You can also type 

the model number in the search field to quickly find something. 

 

9. Download the other two views (front and side) of the toilet. 

 

10. Using techniques previously covered, download all three views 

(plan, front and side), from the Kohler website, for the plumbing 
fixtures listed below: 

• K-2007 Kingston™ wall-mount lavatory 

• K-5024-T Dartfield™ Urinal 

• K-5250 Serra™ Drinking Fountain 

 
When finished you should have the following files listed in your My 

Documents folder: 

 

• 5250sde.dwg 

• 5250pln.dwg 
• 5250frt.dwg 

• 5024tsde.dwg 

• 5024tpln.dwg 

• 5024tfrt.dwg 

• 4329sde.dwg 

• 4329pln.dwg 
• 4329frt.dwg 

• 2007sde.dwg 

• 2007pln.dwg 

• 2007frt.dwg 

 

Next you will draw a “lavatory system” from another major plumbing 
manufacturer called Bradley Corporation; you can also download this one 

from the internet (and you will be given the URL), but the file is composed of 

multiple views and information – plus it is in a ZIP file – which makes for 

more work (as far as this tutorial is concerned). 

 
11. If you prefer to try the download: Browse to the following URL: 

www.bradleycorp.com/prodinfo/fixtures/lavatory/ss2n.htm 

a. Click the link to download the CAD Details. 

 

12. In a new drawing, draw the Lavatory System shown in 
Figure 3-1.5; make sure the origin is at the back and centered. 

a. Approximate all dims and arc’s not specified.  

b. Draw everything on Layer zero. 
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13. Save your drawing into the My Documents folder; name the file 

Lav_System_pln.dwg. 

 
Your new drawing file in now ready to be inserted into the floor plan drawing 

when it is needed! 

 

14. Close the lavatory drawing and Open your floor plan drawing. 

 

You are now ready to add the plumbing fixtures to your floor plan. You will 
start with the small toilet rooms near the main entry. 

 

15. Add the plumbing fixtures as shown in Figure 3-1.6, plus: 

a. Make sure the fixtures go on Layer A-Mech-Pfix. 

b. See Figure 3-1.7a for the grab bar dimensions. 
c. Draw the grab bars on Layer A-Flor-Accs. 

d. The room on the right has a toilet, sink and urinal. 

e. The room on the left has a toilet and a sink. 

f. Add a drinking fountain in the hallway. 

g. Do not draw the dimensions or the dashed lines. 
 
TIP: Select Block… from the Insert pull-down menu, and then 
click the Browse… button – this will allow you to select AutoCAD 
drawing files from your hard drive to be inserted into the current 
drawing (onto the current Layer). 

 

Figure 3-1.5  Draw this lavatory system in a new drawing file with origin centered on the backside
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The dashed lines shown in Figure 3-1.6 represent the clear floor space that 

must be considered when designing the layout of a toilet room. This tutorial 

will not get into the specifics related to the clear floor space at each fixture 
type; but, you may want to consider creating a special layer to place this 

information on so it can be turned off when not needed. 

 

Another technique you might consider related to clear floor space is to add 

these dashed lines to your blocks. You can leave the fixture on Layer zero 
and add the dashed lines on a specific Layer. That way, when the “clear floor 

space” layer is turned off the fixture will still be visible (as long as the fixture 

was not inserted on the “clear floor space” Layer – or any other Layer that is 

turned off). You will employ this technique in Lesson 4 when you create 

furniture and fixture symbols (i.e. Blocks). 

 
 

 

 

 

 
 

 

 

 

 
 

 

 

 

 

 
 

 

 

 

 
 

 

 

 

The sight-lines are not too bad here, considering the shape of the room 
outside the toilet rooms. However, the line of sight is not as critical in this 

situation because the toilet rooms are for single users. Most designer still 

prefer to ensure that plumbing fixtures are not visible from adjacent rooms – 

especially off of main entries and lobbies. In this case you create a small 

alcove-type space where a person needs to go out of their way to be in a 
position where the sight-lines matter; even a person walking straight towards 

the drinking fountain will not have any sort of vantage point towards the 

plumbing fixtures. 

Figure 3-1.6  Place the fixtures shown (do not draw the dashed lines)
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Drawing the Large Multi-User Toilet Room 

You will jump right in and place the plumbing fixtures and then you will add 

the toilet partitions and review the sight-lines from the adjacent hallway. You 

will also review the requirements for wall thicknesses behind the wall-hung 
toilets. 

 

 

16. Insert the plumbing fixtures as shown in Figure 3-1.8, plus: 

a. Make sure the fixtures go on Layer A-Mech-Pfix. 
b. See Figure 3-1.7a for the grab bar dimensions. 

c. The northern room has (3) toilets and a Lavatory System. 

d. The southern room has (2) toilets, a urinal and a Lavatory 

System. 

 
Sight-lines are typically explored by drawing a line from the adjacent 

hallway (or space), through the door opening, into the toilet room. Looking 

at Figure 3-1.8 you can see the sight-lines are quite acceptable. As 

previously mentioned, this design solution takes up a fair amount of floor 

space but is necessary. 

 
An unacceptable design solution is shown in Figure 3-1.9. The toilet room is 

much larger and can even have another toilet fixture without the door 

modification for sight-lines; also, the door is right off the circulation path 

which can be problematic. Notice two lines are shown to visualize the full 

visual range. Granted, some of this view is obstructed by a person’s body as 
they pass through the door opening. 

 

Figure 3-1.7a  Grab bar dimensions; 1 ½” diameter pipe

Figure 3-1.7b  Grab bar picture; codes 
vary by location – Minnesota requires a 
vertical bar as shown above. 
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Figure 3-1.8 Place the fixtures shown; dashed line shows sightline

Figure 3-1.9 Dashed lines reveal unacceptable sightlines into the toilet room

This is the full view 

range in this design 

solution. 
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Adding the Toilet Partitions 

The toilet partitions offer privacy for toilets and urinals. They come in a few 
styles and materials. Styles range from floor mounted to ceiling hung; the 

latter offers better access to cleaning the floors – like wall-hung toilets. 

Materials range from pre-finished metal to Solid Phenolic Core (i.e. plastic) to 

stainless steel. 

 
The divider panels, pilasters and doors come in various thicknesses. 

However, each are typically drawn 1” thick and are dimensioned to the 

center of the panel so the thickness is not too important. 

 

If you want to see images and more information on toilet partitions you can 
visit the Bradley Corporation website list below (select Tech data sheet PDF): 

http://www.bradleycorp.com/prodinfo/mills/600phenolic.htm 

 

 
 

 

Accessibility codes offer several layout options for toilet partitions. For 
example, if the door swings into the stall, more room is required in the stall 

to maintain the required clear floor space for the toilet fixture. Having a 

cheat-sheet of several different layout options is a big help. Consult your 

local code for specifics. 

 
The preceding image is very similar to the Men’s toilet room you are 

currently working on. 

 

17. Draw the toilet partitions as shown in Figure 3-1.10, plus: 

a. Make sure the partitions go on Layer A-Flor-Tptn. 
b. Use lines and arcs to draw the partitions; show all 1” thick. 

c. Do not draw the dimensions. 

d. Draw a 36” wide door into the end stall (i.e. HC Stall). 

e. Draw 30” wide doors centered on the remaining stalls. 

f. Draw the grab bars on Layer A-Flor-Accs. 

 

The example to the left shows a floor 

mounted, overhead-braced toilet 

partition system. 
 

Also notice the urinal screen at the end 

of the countertop. 
 

Floor drains are usually positioned 

beneath a toilet partition so users do not 

have to walk over the slightly uneven 

surface. 
 

Notice the accent floor tile that also 

takes into consideration the location of 

the toilet partitions. 
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18. Add a drinking fountain just to the 

east of the Men’s toilet room, and 

centered on the wall, as shown in 

Figure 3-1.11. 

 
For info on wall thicknesses behind double-hung 

toilets visit: www.pdionline.org and review 

publication: Minimum Space Requirements for 

Enclosed Plumbing Fixture Supports. 

 
This concludes the toilet room floor plan 

exercise. You will study this a little more in the 

toilet room interior elevations tutorial later in 

this book. 

Figure 3-1.10 Drawing the toilet partitions and urinal screen

Urinal Screen 

Toilet Partitions 

Figure 3-1.11 
Drinking fountain centered on wall 
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Exercise 3-2: 

Casework 

 

Introduction 
This exercise covers the basic techniques used to represent casework in plan. 

Casework is typically any built-in cabinets, countertops, desks, bars, etc. and 

is usually installed by a carpenter. This does not include systems furniture 

which is sometimes attached to the wall. 

 
The architectural floor plans typically show the built-in items (i.e. casework) 

and the FFE Plan (furniture, fixtures and equipment) typically show the 

moveable items. The FFE Plans are covered in the next chapter. 

 

The words “typical” and “usually” are used a lot because there is no exact 
science to how a set of drawings are put together. They can vary by country, 

state, city and even office. 

 

First you will draw the casework in the open office area. These upper and 

lower cabinets represent the work area where coping and mailing occurs. 
 

 

Work Area Cabinets 

Cabinets in a work area can vary quite a bit depending on the work being 
performed there. The picture below is similar to what you will be drawing 

next. The base cabinets are on the floor and are typically 24” deep (but 

come in a variety of depths). The wall cabinets are attached to the wall and 

also come in various depths (12” and 14” being the most common). 

 

As you can see the electrical outlets need to be coordinated with the 
electrical engineer – they need to be installed above the countertop and 

below the wall cabinets. When preparing the program, an interior designer 

should get a list of all the equipment required in each area. This will 

determine the number of outlets and locations. Often, items are overlooked 

or added later that can add an unsafe strain on the electrical system or 
require extension cords. For example, it is possible that the microwave 

shown in the image below was added, long after the design of the building, 

by the users – if the electrical system did not have enough capacity it could 

make for an unsafe condition. If that were the case, a new outlet on another 

circuit would need to be added. 
 

Notice two things about the wall cabinets: 1) the cabinets have “under-

counter lights” across the entire length. If this is desired by the 

client/designer, the electrical drawings need to be coordinated and the 

bottom of the cabinet recessed so the light fixture is not directly seen. 2) the 

space between the top of the cabinet and the ceiling is filled in with studs 
and gypsum board for a clean – dust-free- finish (not always in the budget). 
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1. Draw the casework shown in Figure 3-2.1, plus: 

a. Base cabinet lines on Layer A-Case 

b. Wall cabinet lines on Layer A-Case-Abov 

c. Do not draw the dimensions 

 

 
 

Example of typical work room cabinets; see comments on previous page 

Figure 3-2.1 Drawing the work area casework

FYI: The countertop typically extends out 
past the base cabinets by a 1”. 
Thus, in plan, the A-Case lines are 25” 
out from the wall (24” cabinet + 1” 
countertop overhang = 25” countertop). 
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Break Room Cabinets 

The cabinets in the break room have similar considerations as the work room 
cabinets. Additionally, you often have plumbing to coordinate as well (e.g. a 

sink or dishwasher). 

 

The first thing you will do, to prepare for laying out the break room counter, 

is to draw a two-compartment sink. 
 

 

2. In a new drawing, create the two compartment sink as specified below 

(save to your My Documents folder): 

 

filename: Sink-1.dwg 

 

 

Draw this sink per the 

following specifications: 

 

o 2” space (i.e., offset) at 
sides and front. 

o 3” Dia. Circles centered 

in sinks. 

o 2” rad. for Fillets. 

o 1 ½” Dia. at faucet 

spaces; 3 ½” apart. 
o Block dot = Origin 

o All on Layer zero 

 

 

 

 

3. Draw the cabinets shown in Figure 3-2.2, plus: 

a. The wall cabinets extend the full length of the room (14’-6”) 

b. The 3’-0” space will accommodate a refrigerator 
c. The countertop is at two heights; the sink area is lower for 

handicap accessibility (covered more with interior elevations). 

d. Add the two-compartment sink drawn in the previous step. 

e. Ensure the sink is placed on the correct Layer (tip: plumbing). 

 

 

 

 FYI:  
The wall cabinets are shown with dashed linework in plan because they are 
assumed to occur above the floor plan cut plane. This also helps to differentiate 
between wall and base cabinets. 
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4. Draw the cabinets shown in Figure 3-2.3, plus: 
a. The wall cabinets are 14” deep. 

b. The countertop is 25” deep. 

 

 

 
 
 

Figure 3-2.2 Drawing the break room casework

Figure 3-2.3 Drawing the copy room casework

Wall and Base cabinets in 

copy room; added in this step. 
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Checkout Counter 

In the previous steps you placed base and wall cabinets, now you will design 
the checkout counter. The checkout counter is what is referred to as “custom 

casework”. The base and wall cabinets can also be “custom casework” or it 

can be ordered from a catalog. 

 

Basically, “custom casework” is anything a local cabinet/woodworking shop 
would build. Typically built in their shop and assembled on-site. 

 

Custom casework gives the designer a wide range of functional and aesthetic 

opportunities. As you can see in the Figure on the next page (Figure 3-2.4), 

the angles and curves require a custom built solution; these shaped cabinets 
are not found in a catalog of standard cabinets. 

 

The cost associated with custom casework is, of course, higher than standard 

– stock- items. When the client can afford custom, they have the opportunity 

to get a more functional space in which to work. For example, a drawer can 

be located wherever it is needed and a cubby can be made just the right size 
to hold the companies “odd” sized shopping bags (which make for better use 

of space and keeps the bags stacked neatly). 

 

The checkout counter represents a drafting exercise where you have to draw 

various angles and curves per the given instructions. It is easy to draw 
linework in AutoCAD that kind of looks like what it should be, but it is the 

designer/drafters responsibility to draw things accurately so things go 

smoothly during construction. This type of structured drafting, no matter if 

on your own time or in a classroom setting, will make you better prepared 

and more efficient in the workplace. Your instructor may have you print the 
checkout counter to scale and check it with an accurate drawing on 

transparence paper. 

 

 

5. Draw the checkout counter shown in Figure 3-2.4, plus: 

a. Draw all linework on A-Case layer. 
b. The countertop is 36” deep. 

c. The doors (i.e. gates) are 36” wide. 

d. The exact location of the gates does not matter (visually close) 

e. Do not draw the dimensions. 

f. The 55’-4 5/8” is where the angled line stops and the curved 
line begins. 

g. TIP: Draw one side of the counter and then use Offset to 

create the other side. 
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Figure 3-2.4 Drawing the checkout counter casework

Custom casework can come in 

many finishes… 
 

The helpdesk example to the 

left has a wood finish for the 

front and solid granite for the 

countertop. 
 

This author recently worked 

on a new 32,000sf Ranger 

Station for the US Forest 

Service where the main 

reception / information 

counter had a stone front 

which matched the buildings 

exterior. 
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Thinking about sightlines again, looking at Figure 3-2.5, you can see the 

sightlines that have been added show how the design of the counter 

enhances the Librarian’s ability to monitor the adjacent spaces. 
 

 

 

 
 
 

 

 

 
 
 

Figure 3-2.5 Reviewing sightlines associated with the checkout counter

Checkout Counter Example Second floor view showing gate and accessible 
checkout area with lower countertop. 
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Exercise 3-3: 

Stairs and Elevators 

 

Introduction 
In this exercise you will add the stairs and elevators. There are several things 

to consider when drafting and designing these components within a building. 
Similar to the plumbing fixtures, you will download the elevator drawings 

from the internet. 

 

 

Adding the Passenger Elevators 
Elevators come in several models and sizes. In this tutorial you will be adding 
two passenger elevators and a service elevator. Selecting the model and size 

depends on several factors such as: expected number of passengers in a 

given period of time, number of floors served, budget and speed to name a 

few. 

 

In this made-up library project, the passenger elevators will have high 
quality finishes and are indented primarily for people (i.e. the public and 

staff) and book carts. The service elevator is only accessible by staff and has 

durable finishes to withstand large items being moved in and out on a 

regular basis. 

 
The following steps could aid in determining the elevator shaft size. However, 

this information was previously given when you drew the walls. 

 

Again, you will need access to the internet before proceeding with this 

exercise. 

 

 

1. Open your Internet Browser; this book uses MS Internet Explorer. 

 

Next you will be instructed to browse to a major elevator manufacturer’s 

website. 

 
2. Browse to the ThyssenKrupp Elevator website by entering the URL 

www.thyssenkruppelevator.com and then press Enter…  or click 

Go. 

 

3. Click the Architect Direct link near the top of the webpage. 
 

4. Now select the Drawings link. 
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5. Enter the following information (see Figure 3-3.2): 
a. Type of Application:  Traction geared 

b. Capacity:   3000 

 

6. Click the icon under the label Drawings (see image below): 

 

 

 

 

Figure 3-3.1 Elevator manufacturer’s website

Click here 

Click 

here 
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7. Click the DWG icon next to Hoistway and MR + 200 (speed) as 

shown in Figure 3-3.3. 

 

 

 

Figure 3-3.2 Elevator manufacturer’s website

Figure 3-3.3 Elevator manufacturer’s website

Click here to 

download the 

drawings 
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8. Click the Save button (Figure 3-3.4) and browse to your My 

Documents folder. 

 

 

 

 

You now have an AutoCAD drawing file named SS041.DWG saved on your 

computer’s hard drive. This drawing is shown in Figure 3-3.5, and is packed 

with information. As you can see, details about the elevator shaft and the 
elevator machine room are given. In your case, this is more information than 

you need. So, you will open the drawing and Copy/Paste what you need into 

your floor plan. 

 

 

 

Figure 3-3.4 File Download dialog

Figure 3-3.5 Contents of drawing file just downloaded
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9. Open SS041.DWG (the elevator drawing just downloaded). 

 

10. Zoom in to the elevator shaft plan view on the right. 
 

 

Layer Freeze: Format menu tool 
Next you will use a Format menu tool to freeze a Layer just by selecting 
objects on the screen. This will help you to select just the parts of the 

drawing you need. 

 

11. Set the current Layer to 0 (i.e. zero). 
 

TIP: Click the Layer drop-down list from the toolbar and scroll up to Layer 
zero and click on it; as long as nothing in the drawing is selected, this will 
make the selected Layer current. 

 

 
12. From the Format menu, select Layer tools � Layer Freeze. 

 

 

 

 

 

 
13. Click on all the text, dimensions and centerlines until the drawing 

looks like Figure 3-3.6 

 
TIP: If you click on the wrong object and a Layer is frozen by mistake, type 
U and press Enter on the keyboard. 

 

 

The elevator drawing is almost ready 
to be copied to the clipboard and 

pasted into your floor plan. 

 

Before you copy the drawing to the 

clipboard, you will fix the broken lines 
(they were trimmed to accommodate 

notes and dimensions – which are now 

frozen). 

 

Also, all the visible linework is 
currently on a Layer named “Object” 

which does not conform to your office 

standards – you will fix this too. 

 

 

 

Figure 3-3.6 Elevator drawing 
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Using the Join Command 
The join command allows you to select two or 
more aligned lines and turn them into a single 

line. You will try this next. 

 

 

14. Select Join from the Modify menu. 
 

15. Select the three lines identified in 

Figure 3-3.7 and then press Enter. 

 

 

 
 

 

 
 

 

16. Continue to use the Join 

command to cleanup all three 

sides of the elevator car as 
shown in Figure 3-3.8. 

 

In the next step you will change all the 

linework to Layer zero before you 

copy/paste into your floor plan. If you 

did not do this the Layer named “Object” 
would be created in your floor plan 

drawing. These types of extra Layers are 

not desirable. 

 

17. Select everything visible in 
Figure 3-3.8 and change its 

Layer to 0 (i.e. zero). 

 

Figure 3-3.7 Elevator shaft drawing

Select these three lines 

using the Join command 

Figure 3-3.8 Elevator shaft drawing
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Next you will mirror the elevator to 

align the orientation with your plan. 

 
18. Mirror the elevator as shown in 

Figure 3-3.9 

 

Copy with Base Point 

Next you will copy the elevator to the 

MS Windows Clipboard. This is a 

placeholder for information (it can be 

used within the same application or 

between programs – e.g. Copy from 
AutoCAD and Paste into MS Word). 

 

AutoCAD offers the ability to specify a 

Base Point before placing the drawing 

information in the Clipboard. Thus, 

when you Paste the drawing information back into the same drawing or 
another drawing you can accurately place it. 

 

19. Select Copy with Base Point from the Edit pull-down menu. 

 

You are now prompted to select a Base Point: 
 

20. Pick the point identified by the black dot in Figure 3-3.9. 

 

You are now prompted to select items to copy to the clipboard: 

 
21. Select everything in Figure 3-3.9 except the walls which have been 

shown dashed for clarity (you already have walls in your plan). 
 

a. TIP: You can use a crossing-window to select everything and then 
hold down the Shift key while selecting the wall lines (which will 
remove them from the selection set). 

 
22. With everything but the wall lines selected, press Enter. 

 

The elevator has now been copied to the clipboard. That information will 

remain there until the computer is turned off or AutoCAD (or any other 

program) copies new information to the clipboard. 
 

 

 

 

 
 

 

 

Figure 3-3.9 Elevator mirrored 

Try this:  
While the drawing data is still in the clipboard, try opening a word processor like 
MS Word and select Paste from the Edit menu. Notice how the drawing looks in 
the document. 
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23. Switch back to your library floor plan. 

 

24. Zoom in on the elevator shaft near the main entry. 
 

25. From the Edit pull-down menu, select Paste (or Ctrl + V). 

 

You should now see a ghost image of the elevator attached to your cursor. 

The Base Point previously select is now the insertion point. 
 

26. Select the same, relative, location as the insertion point – shown as 

a black dot in Figure 3-3.10. 

 

 
 

 
 

You now have one of the two elevator cars located within the shaft. In this 

plan you will have two elevators in the same shaft – separated only by a 

beam at each floor. So you still need to mirror the car and trim the wall lines 

at the elevator door opening. 
 

27. Use the Mirror command to copy a mirror image of the elevator car 

to the opposite side of the shaft (see Figure 3-3.10). 

 
TIP: Use the midpoint of one of the vertical wall lines to establish the 
Mirror Line (with Ortho on). 

 

28. Trim the wall lines and place the jamb lines on A-wall layer (not the 
elevator frame – just the line that closes off the wall) – Fig. 3-3.11. 

 

29. Move all the elevator lines to the proper layer (see Appendix A). 

 

 

Figure 3-3.10 Elevator inserted into your floor plan (black dot in lower-left for reference only)
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The Weight of Finishes? 

Finishes are very important for several 
reasons when it comes to elevators. As 

previously mentioned the use needs to be 

considered (passenger or service); this will 

dictate the durability and cost of the finishes. 

 
Another consideration is the weight of the 

material. If the Interior Designer selects wood 

wall panels and tile flooring (which is 

perfectly acceptable) the elevator 

manufacturer needs to know how much these 
materials will weigh so they can properly size 

the motor for optimum performance. 

 

So, similar to coordinating with the Electrical 

Engineer at casework locations, coordination 

must also occur with many other items in the 
building that the Interior Designer is directly 

responsible for. 

 

 

30. Add two lines, 4” apart between the 
elevators to represent a beam – 

place the lines on the same Layer as 

the elevator. 

 

 
Your elevator should now look like Figure 3-3.11. Several details are drawn, 

such as the guide rail, the cab door, the floor level door and even the pit 

ladder. 

 

Many Architectural firms have a copy of the major elevator manufacturer’s 

technical catalog which provides enough information to manually draw 
everything in Figure 3-3.11. But it is not difficult to see how the internet can 

save time when AutoCAD content is available; not all manufacturers provide 

AutoCAD drawings of their products. 

 

 
 

 

 

 

 
 

 

 

 

Figure 3-3.11 Elevator added to plan
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Adding the Service Elevator 
This elevator is near the loading dock area and is only accessible by the 
library staff. It is rated for a higher capacity than the passenger cars 

(3000lbs. vs. 5000lbs.). The cab size is also larger to make it easier to move 

objects in and out. 

 

You will be given minimal information with the expectation that you use the 
knowledge previously learned to locate and insert the drawing data. 

 

 

31. Place the service elevator per Figure 3-3.12, plus: 
 

a. Use the same mfr: ThyssenKrupp Elevator 

b. Type of application: Traction geared 
c. Capacity: 5000 

d. Note the door orientation 

 

 

 
 

 
 

 

 

 

Figure 3-3.12 Service elevator added to plan
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Adding the Open Stair 
The open stair is the primary stair used for vertical circulation in a building. 
This type of stair offers visual way-finding and can make an aesthetic 

statement for the building when located and designed well. Building codes 

often allow an open stair between two floors only; if one wishes to have a 

multi-story open stair it must have the ability to be closed off – which usually 

means overhead door-like fire shutters that will be lowered in the case of a 
fire. 

 

Below is an example of a well designed multi-story open stair. The railings 

are glass with a wood cap, the treads and risers are high quality terrazzo and 

the walls are lined with wood panels. The stair is located next to windows 
which help the users know where they are in the building relative to the 

outside (helps with way-finding). The photo was taken through a large piece 

of glass that makes the stair visible at each floor within the building – in the 

event of a fire the fire-shutters come down and close this view off! 

 

 
 

 

 
 

 

 

Open Stair Example High quality stair with interesting design
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32. Draw the open stair per Figure 3-3.13, plus: 
 

a. The tread lines are 13” apart 

b. Draw the treads on Layer A-Flor-Strs 
c. The railings are to be drawn 2” wide and 2” out from the wall 

d. The railings that are not continuous extend past the top/bottom 

riser by 12” and return to the wall. 

e. Draw the railings on Layer A-Flor-Hral 

f. The dashed lines represent the stairs and floor opening above 

the floor plan cut line. 
g. Draw the dashed lines on Layer A-Flor-Strs-Abov 

h. Use the Leader command to draw the arrow (TIP: while in the 

command type “S” for the settings dialog) + Dimscale = 96 

i. Use the Donut command to make the black dot (TIP: set the 

inside radius to 0” and the outside to 4”) 
j. Add the text (per standards for 1/8” scale; 9” high) 

k. Draw text and arrow on Layer A-Flor-Strs 

l. Do not draw the dimensions 

m. Draw the angled line shown on the stair Layer. 

 

 
 Figure 3-3.13 Open stair to be drawn
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The angled line that trims the tread lines in Figure 3-3.13 represents the cut-

line of the floor plan. The location of this line is not too critical, it is best to 

place it where the major features of the stair can still be shown. Depending 
on the distance between floor levels, you might have a significant space 

below the stair and need to show seating or flooring patterns. Codes require 

the lower portions of the stair (i.e. under the stair) to be enclosed so the 

visually impaired do not run into the stair. Sometimes it is desirable to 

enclose the underside of the stair completely to avoid hard too clean spaces; 
in this case you might see a wall pickup on the other side of the cut line. 

Even though the stair reached up past the cut line, the wall resting on the 

floor still continues for the length of the stair. 

 

 
 

The handrail extension is dictated by the building code. The same is true with 
the handrails returning to the wall; this prevents people exiting the building 

(or fire fighters entering) from getting entangled with the handrails. The 

figure below (3.3.14) shows an elevation view of a wall mounted handrail to 

help you better understand what you are drawing. 

 

 
 

 

 

In this floor plan, you would most likely add furring to the south wall to cover 
the structural concrete column. 

Figure 3-3.14 Handrail detail

The image to the left is showing, 

three-dimensionally, how the floor 

plan cut plane impacts a stair which 

has a wall under it. In plan view, the 

break-line is added where the stair 

extends above the cut-plane; beyond 

the cut-plane you would show the wall 

below the stair because it is now 

passing through the cut-plane. 
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Adding the 

Utilitarian Stairs 
The two utilitarian stairs 

are almost identical; this is 

ideal whenever possible 

because it reduces the 
number of stair sections 

and details that are 

required in the 

construction documents. 

 
As already discussed, the 

utilitarian stairs are not 

readily visible and 

primarily meant for 

emergency egress; their 

existence is primarily 
dictated by code. They are, 

however, often used as a 

means of vertical 

circulation within the 

building. 
 

The finishes and light 

fixtures are simple – often 

painted CMU walls and 

surface mounted lights. 
 

 

 

 

33. Following the same instructions as the previous step, draw the east 
stair per Figure 3-3.15, plus 

a. Draw the inside handrail 2” in from the stair edge (see photo). 

b. Draw two angled break lines with void between. 

c. The tread lines are 11” apart. 

 

 
Notice in Figure 3-3.15 that the angled break lines help to delineate both the 

up run and the down run – which would otherwise overlap and be confusing. 

 

 

34. Using Copy (or Copy to clipboard) and Mirror, copy the east stair into 
the west stair shaft (see Figure 3-3.16). 

 

Utilitarian Stair Example 
Durable, average cost stair with simple design 
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Why two walls at the exterior walls in the stair shaft?   

This is a problem that requires the ability to think three-dimensionally. It 
should be obvious to you that a beam spans between two columns; typically 

at each floor level and at the roof. Well, the stair shaft is a tall room that 

passes multiple floors. Thus, the stair shaft needs to occur outside the beam 

line – which is centered on the column/grid lines. 

Figure 3-3.15 East utility stair shaft
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If you were drawing the other floors in this building you would Copy/Paste 

the stairs to the other drawings; the upper floor and basement would need to 

be modified. 

 

Figure 3-3.16 West utility stair shaft
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In stairs, building codes often require a gate at 

the ground level and at the upper level (if the 

stair continues to the roof) as shown in the 
photo below. The reason for this is to help guide 

people in an emergency. Each floor in the 

utilitarian stair shaft looks the same, so it would 

be easy for a person (especially in a panicked 

state) to pass the ground level exit and continue 
down one or two more floors to the basement; 

extending their time in a dangerous situation. If 

the stair is used for normal, day-to-day, vertical 

circulation, some building officials will allow the 

gate to be placed on a magnetic hold-open 

which allows the gate to close in the event of a 
fire. 

 

Most commercial codes also require that a sphere 4” or larger not be able to 

pass through the guardrail. This has a large impact on design be creates a 

safe environment for the users; looking that the photo above it is not difficult 
to see how older codes allowed for unsafe designs! 

 

Also notice, in the photo below, that the handrails return to guardrail or the 

wall as previously discussed. 
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Exercise 3-4: 

Annotations 

 

Introduction 
This exercise involves adding room names and numbers, as well as each 

rooms square footage. 

 

Room numbers typically start at the main entry and then proceed in a logical 

direction (e.g. clockwise). Sometimes the numbering is coordinated with the 
signage schedule (i.e. the rooms that are not numbered on a sign get 

skipped until the end numbers). 

 

You will start the room numbering at the main entry and work in a clockwise 

direction. Later, you will use this information to generate a room finish 
schedule. 

 

Room numbers will be three digits, with the first number corresponding to 

the floor that room is on. For example, the janitor’s closet on the first floor 

might be 134 and the janitor’s closet on the third floor might be 312.  
 

To get the square footage, one can draw a Polyline and use the Area 

command to list its square footage. Specifically, draw a continuous Polyline 

(pline) using Object Snaps, before picking the last point (i.e. the starting 

point) type C for close to create a Closed Polyline; and then type Area and 

select the polyline – the square inches and square foot will be listed. The 
ployline can be placed on Layer A-Area-Bdry and turned off for future 

reference (e.g. the room size changes and you need to update the area). 

 

The text for the room names will be AutoCAD Style Bold per the “office 

standards” (see appendix A). The room name and number will be 12” high 
and the square footage text will be 9” high. All the text (name, number, sf) 

shall all be in one Mtext object (i.e. typed all at once – not three separate 

commands). Just like working in a word processors, you can select a portion 

of text and edit its properties – this is how you have two text heights in one 

Mtext object. 
 

 

1. Add the text to the Vestibule as shown (as Mtext) in Figure 3-4.1, 

plus: 

a. Place text on Layer A-Area-Iden. 

b. Style: Bold. 
c. Room name and number: 12” high. 

d. Square footage text: 9” high. 

e. All text in one Mtext object. 
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Next you will be given several plan views with all the room names, numbers 

and square footages. If you have trouble reading the numbers in this 

textbook, use the information given above to number the rooms and derive 
the square footage for each room. 

 

 

2. Add the room information (as Mtext) for the remaining rooms, as 

shown in Figures 3-4.2 – 2-4.5. 
 

The text location can vary in each room. But the ideal location is centered in 

the room and aligned with adjacent room labels. These locations get moved 

as the plans develop so the text does not overlap 

furniture/notes/dimensions/etc. 
 

Once you get one room label setup with the properly formatted text (i.e. 12” 

and 9” high text) you can copy that one, with Ortho on, into other rooms. 

Once copied, you can double-click on the text to open it in the Mtext editor. 

Using Ortho helps to keep the text aligned horizontally or vertically. 

Figure 3-4.1 Adding vestibule name, number and square footage
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Figure 3-4.2 Adding room information

Figure 3-4.3 Adding room information
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Figure 3-4.4 Adding room information

Figure 3-4.5 Adding room information 
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Exercise 3-5: 

Presentation Graphics: Solid Filled Walls 

 

Introduction 
The walls are often filled solid during the Schematic Design and Design 

Development phases so the walls punch out better when presented to the 

client. This is done using the Hatch command and the hatching is placed on 

a special Layer that can be turned off as the plan develops (into the 
Construction Documents phase). 

 

One of the many unspoken rules in many design firms is that hatching should 

be limited to only a few (or one large) areas. For example, when using the 

Boundaries: Pick Points feature of the Hatch command (a feature that 
automatically finds the boundary of an area by picking a point anywhere 

within the enclosed area) you need to limit how many points you pick at one 

time – or make sure you check the “make separate hatches” check box.  

 

Otherwise, you might hatch half the plan which would be a single entity. If 

you need to change one little area (e.g. a wall moves 1” to the west) you 
would have to erase the hatch and recreate the hatching for half the plan. 

 

Another thing to be careful of is not to create too many “little” hatches in one 

area. For example, if you do check “make separate hatches”, each click of 

the mouse creates a separate hatch – so if grid lines and break lines cross an 
area of wall it would be better if that hatch was one object rather than 

several small hatches that look like one. 

 

Don’t forget the power of the Block! If you had to add a solid fill to the 

structural columns, you could simply double-click on one of the columns to 
open it in the Block Editor (as instructed in Lesson 2), add the hatch and 

save/redefine the Block. All the columns will automatically be updated! Make 

sure the hatch is placed on a separate Layer so its visibility can be controlled 

independently from the column itself. 

 
Now you will hatch all the walls with a solid hatch; placing the hatch on a 

special Layer… 
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Looking at Figure 3-5.1 you can see it would take three picks just to hatch 

the area between the two windows. Also, the grid lines bisect several walls 

which would require several extra picks as well. This is one of the main 
reasons for dividing things up onto separate Layers – so you can turn them 

off when they are not needed. 

 
1. Using the Layer Off tool from the Format � Layer tools menu, turn 

off the grid lines and the wall cavity lines (see Figure 3-5.1). 

 
Notice how the Layer Off tool was able to turn off the grid line Layer even 

though it was part of an external reference! 

 

 

 

 
 
 

 

Notice the floor plan in Figure 3-5.2, the walls are uninterrupted and ready to 

be hatched. 

Figure 3-5.1 Plan view near east stair shaft
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Next you will create a Layer to place the wall hatch on. 

 

2. Create Layer A-Wall-Patt-Temp (color red) and set it current. 

a. If you want the hatch to be a shade rather than solid black you 

can set the Layer color to 253 or 254. 

 

With the Layer set current, all hatching will be placed on the proper Layer – 

avoiding the need to select the hatch and switch its Layer after it has been 

drawn. 

 
3. Select the Hatch icon on the Draw toolbar  

or type H and Enter on the keyboard. 

 

4. Set the hatch Pattern to Solid (Figure 3-5.3). 

 
5. In the Options area, check Associative (Figure 3-5.3). 

 

6. In the Options area, check Create separate hatches (Figure 3-

5.3). 

 

7. Set the Draw Order option to Send behind boundary. 
 

 

 

 

 
 

 

 

Figure 3-5.2 Plan view near east stair shaft

FYI:  
The Associative feature of the Hatch command can be very handy. When it is 
checked, AutoCAD remembers the boundary that was used to create the hatch, 
and if the boundary changes that hatch is updated. So if you stretch a wall 12” to 
the east the hatching will update automatically. If any part of the boundary gets 
erased the associativity will be lost.  
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8. Begin clicking within walls to select areas (they will highlight as you 

select them); press Enter and then click OK to close the hatch 

dialog box. TIP: Even with “create separate hatches” checked you should 

still limit the number of areas you select at once to avoid messing up and 
having to start all over again. 
a. Do not hatch the concrete columns at this time 

 

9. Continue the hatching process until all walls are hatched. 

a. Again, do not hatch the concrete columns at this time 

 

 
As you can see in Figure 3-5.4 the walls and window punch out very well 

compared to Figure 3-5.1. This is also true for items like casework and 

furniture – they read better! 

 

Figure 3-5.3 Hatch dialog box
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Once you get all the walls hatched you will want to turn the grid lines and 
wall cavity lines back on. There are two ways to do this quickly. 

 

• If you have not made any other Layer manipulations 

or closed AutoCAD, you can simply click the Layer 
Previous icon. 

 

• Another method is to open the Layer Manager and right-click on 

any Layer name and click “Select All” from the pop-up menu. 
Then you can click any Layer icon that is “off” and all Layers will 

be turned “on” (see Figure 3-5.5). 

 

10. Using one of the methods just described, restore the visibility of the 

A-Wall-Cvty and DJS55803AGD01|A-Grid Layers. 
 

Your drawing should now look like Figure 3-5.7. 

 

Figure 3-5.4 Plan view near east stair shaft with walls hatched
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Take a moment and notice the other tools available in the right-click pop-up 

menu shown in Figure 3-5.5. 

 

In the text box (that has the light gray words “Search for layer”)in the lower 

left of the Layer Manager (see Figure 3-5.5) you can type something like 
*grid* and see only the Layers that have the letter/word “grid” in it (e.g. A-

Grid, A-Grid-Iden, DJSAGD01|S-Grid, etc). See the example below, in Figure 

3-5.6, for an example where only the Layers with the word “wall” are listed. 

 

 
 

 

 
 

 

 

 

 
 

 

 

Figure 3-5.5 Layer Manager; right-click and pick “select all”

Figure 3-5.6 Layer Manager; search for “wall” layers

 

 

TIP: Right-click on toolbar area with no icons 
(image to left) and then select Acad � Layers II 
to make a toolbar appear (image above) that has 
the Layer tool commands ready to use at the click 
of a mouse. Then you can drag the toolbar to any 
side of your screen to “dock” to that side. 
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Figure 3-5.7 Overall floor plan with walls filled solid
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Self-Exam: 
The following questions can be used as a way to check your knowledge of this 
lesson. The answers can be found at the bottom of this page. 
 

1. All drawing data downloaded from the internet is perfect. (T/F) 
 
2. Sightlines are important in toilet room designs. (T/F) 

 
3. Right-click a Layer name to select all Layers in Layer Manager. (T/F) 

 
4. The handrails for the stairs go on _______________ layer. 

 
5. Which hatch feature saves you from having to re-hatch an area when you 

stretch a wall to a new location? _________________. 

 

 

Review Questions: 
The following questions may be assigned by your instructor as a way to assess your 
knowledge of this section. Your instructor has the answers to the review questions. 
 

1. Toilet partitions are typically drawn 1” thick. (T/F) 
 
2. Countertops are drawn 25” for a 24” deep base cabinet. (T/F) 

 
3. Wall cabinets are shown with dashed lines in floor plans. (T/F) 

 
4. The Layer Previous icon restores the condition of any Layers from the last 

time they were changed (T/F) 
 

5. You can Copy/Paste items between drawings. (T/F) 
 

6. In the Layer Manager, you can modify the list of layers to just show the 
Layers that just have “door” in them? (T/F). 

 
7. What did you draw in order to list a room’s area? ___________________ . 

 
8. What command mends two lines together?  ________________ . 

 
9. What command lets you freeze a Layer by selecting an object on screen?   

 
____________________________. 

 
10. You can only have one text height within an Mtext object. (T/F) 

 

Self-Exam Answers: 

1 - F, 2 - T, 3 - T, 4 – A-Flor-Hral, 5 – Associative 
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